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This Fallon Creative Library (FCL) Upload Manual is a comprehensive interactive manual/tool designed 
to help your core team navigate through all areas of the FCL. It has been developed based on Fallon 
Minneapolis’ current workflow processes. It should provide the core team with all the necessary detail 
and direction to help begin preparing for the initial uploading of files and also the implementation of 
new processes to make future uploading seamless.

After you learn and understand the general dynamics of this new system, we will work with you to 
develop appropriate processes tailored specifically to your individual office workflow.

Then, prior to the FCL launch in your office, we will adapt this training manual accordingly so each 
office has current processes available that everyone in your office can follow.

This document manual is intended to assist you in all facets of the process of uploading files to the 
FCL. It covers the involvement of Project Management, Art Production, Broadcast Production, Print 
Production, and IT.

The icons you will see in this document manual expand on the information listed. Rolling your mouse 
over an icon will pop-up some information. Clicking on an icon will take you to a page of more detailed 
information.

“The Brain” displays more detailed information about a topic.

“The Eye” provides you with a relevant example.

“The Page” takes you directly to a page for more specific information.

Any time you see “The Hand,” click to take you to a details page.

Jump to the “Who 
to Contact” page

Print different components 
of the FCL Guide

Takes you back to 
where you came from

Navigate forward 
or back a page

overview

TABLE oF CoNTENTs

GET sTARTEd

BACkGRoUNd BEHINd 
THE FCL

>
Content continued or 
click for more info

return to 
Previous Pagesend an eMail to:

LIsA RoGERs

BRAd ZENNER

WAdE sTUART

Print this section

Print entire Manual

Print this section

Print entire Manual

mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Page �return to 
Previous PageExit

ta
b

le
 o

f 
c

o
n

te
n

ts

ILLUsTRAToR

PHoTosHoP

QUARk

FREEHANd

INdEsIGN

ovERvIEW

BACkGRoUNd 
BEHINd THE FCL

ART
PRodUCTIoN

BRoAdCAsT 
PRodUCTIoN

MoRE UPLoAdING 
INFo

WHo To CALL

METAdATA 
sTANdARds

soFTWARE 
REQUIREMENTs

NAMING 
CoNvENTIoNs

GLossARy oF 
TERMs

APPLICATIoN-sPECIFIC 
dETAILs

UsER GUIdE

ART
PRodUCTIoN

BRoAdCAsT 
PRodUCTIoN

PRoJECT
MANAGEMENT

AvId

CLEANER

FINAL CUT PRo

ITUNEs

QUICkTIME PRo

details

INITIATE JoB

dETERMINE 
vERsIoN

IdENTIFy TyPE oF 
WoRk 

PRovIdE METAdATA

vERIFy

Project 
ManageMent

RECEIvE WoRk

dETAILs FoR PRINT 
WITH ART

dETAILs FoR PRINT 
WITH No ART

RECEIvE METAdATA

APPLICATIoN-sPECIFIC 
dETAILs

UPLoAd

art
Production

RECEIvE WoRk

dETAILs FoR Tv
dETAILs FoR 

RAdIo

RECEIvE METAdATA

APPLICATIoN-sPECIFIC 
dETAILs

UPLoAd

Broadcast 
Production

CoNNECTIoN To 
sERvER

CUMULUs CLIENT

CUMULUs sCAN

Add METAdATA

CoPy AssET

FoR ALL: 
MARk APPRovEd

B’CAsT PRodUCTIoN: 
CREATE/UPLoAd 

THUMBNAIL

ART PRodUCTIoN: 
CHECk FoR REPRINT

vERIFy

uPloading

send an eMail to:

LIsA RoGERs

BRAd ZENNER

WAdE sTUART

Print this section

Print entire Manual

Print this section

Print entire Manual

mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Project 
ManageMent

Broadcast 
Production

art
Production

uPloading details

Page �return to 
Previous PageExit

tablE of 
ContEnts

ovERvIEW

TABLE oF CoNTENTs

GET sTARTEd

Background Behind 
the Fcl

The Fallon Creative Library (FCL) is a globally accessible, long-term digital archive that contains all finished 
Fallon print, ooH and broadcast creative. Whenever there’s a need for an asset (for new business, award 
show entries, presentations, internal briefings, pr, fallonet, fallon.com, etc.), it can be easily accessed, 
viewed and downloaded from the FCL.

The FCL transforms knowledge management at Fallon as we know it, allowing all Fallon offices to work 
smarter and more efficiently. As a global agency with global clients, sharing our work between offices 
worldwide is essential to our success in the global economy. The FCL gives us the speed to do this 
instantaneously, making us all better informed and more connected than ever before.

The FCL makes the traditional requests for copies of our work a thing of the past: it reduces manual 
search, production and distribution time, as well as time and money spent on reprints, color copying and 
overnight shipping. When a reprint is required, the FCL contains a reprint section where thumbnails of all 
available reprints can be viewed and easily ordered. 

Not only are assets continually uploaded seamlessly, but they are also accompanied by detailed 
Metadata−Metadata that immediately provides specific pertinent information and answers to help reduce 
time spent finding the information holder and/or searching through stored files. It can also serve as a 
quick reference point regarding any usage or talent limitations for any asset, adding another level of 
protection against any potential misuse. 

The FCL is a great new tool in our ever-growing Technology Toolbox. These tools are developed as either 
internal or external resources. The FCL is a Fallon internal resource only, but can feed all our external 
tools, such as extranets. 

The FCL will continue to grow and evolve as we identify new needs and uses for it. In fact, it’s evolved 
significantly since the initial development in late 2003. And already, many additional enhancements have 
been identified and are now being planned for a phased implementation. 

At a time when clients want more for less, resources are tight or fragmented, timelines are compressed as 
never before, and everyone’s working on deadline, the FCL empowers all users to work faster, smarter and 
more independently. We wonder how we ever got along without it for so long!
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Role of PRoject ManageMent

initiating a Job

Project Managers are responsible for opening all jobs on 4d. Included on the 
job start is the full team. 

When a print job is complete, the Project Manager determines which version of 
each print concept (page, spread or ooH) should be uploaded.  

  
for Print work:
 The cost of the high-res file is included in all Print estimates, and that 

cost is set by Print Production.
 
 Print Production sends the high-resolution art to Art Production.

 Production Artist begins preparing asset for upload. Metadata is sent to 
the Production Artist for Upload.

When a print job is complete, the Project Manager e-mails the 
Production Artist via 4d e-mail tab. This is the alert to the Production 
Artist that this version needs to be added to the creative library.

for broadcast work:
 Post Production creates an mpeg from the digibeta copy they receive.

studio Editor begins preparing asset for upload. Partial Metadata has 
already been sent to the Production Artist from the Broadcast Job 
Report.
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initiate joB

deterMine version

identiFy tyPe oF work 

Provide Metadata

vERIFy >

>

When beginning the process of gathering files to upload to the FCL, 
The Project Manager needs to:

1. Run all job numbers by client for all work produced
2. Print the list of job numbers used
3. Highlight which jobs will be uploaded (as finished work)
4. Find the job number for the most representative version 
5. Populate the Excel Asset Worksheet for each asset to prepare for the 

inital batch upload

Project Manager
7/06/05 12:49 pm

TO:

CC:

BCC:

Subject:
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After the spot is complete, finished Metadata is sent to the studio Editor 
from the finished Broadcast Job Report. 

Although the Project Manager is aware when a spot is complete, he or 
she does not alert the Assembly Line. This is the Producer’s responsibility.

Verification

Just as important as adding the files is making sure the correct information is 
there. The FCL works only if the content is uploaded in a timely and accurate 
fashion.

For both Print and Broadcast, it is the Project Manager’s responsibility to log 
onto the FCL a few days after the work is complete to ensure it has been added. 
If it hasn’t, they will alert the appropriate departments and make sure it is 
completed right away.

INITIATE JoB
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aRt PRoduction

for Print/ooh work with art:
After completing a job, Pre-press transmits high-resolution (300 dpi) art file to 
Print Producer as a Psd file. Print Producer then sends file to Art Production for 
PdF creation.

Print Producer sends e-mail to Project Manager and Production Artist advising 
them that medium-res artwork has been sent to Fallon.

for Print/ooh with no art:
After Production Artist transmits the mechanical to Pre-press, Production Artist 
creates the PdF (within 48 hours) based on the application-specific details.

receiVing Metadata

Project Manager emails Production Artist the Metadata/slug info, which also 
identifies the correct location for the finished PdF.

aPPlication-sPecific instructions for Pdf creation

Production Artist drops art into mechanical, creating a print-quality PdF (within 
48 hours of receiving email notification).

Illustrator Indesign Photoshop Quark Freehand

naMing the file

Production Artist should follow this format for naming the file:
Job Number_name of work.pdf 

The last step for the Production Artist is to upload the asset to the Creative 
Library.

don’t forget about font licensing! read More about it.
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ART
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UPLoAd
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Click to view the Art Production 
Application-specific details

sample Filename:
 bah10322v2 Binder Clips.pdf  >

Click to see an example of slug information

After Print Production sends high-res file to Art 
Production, Production artist creates medium-res 
PdF for the FCL, and prepares the high-res file 
for archiving.

Minneapolis requests high-res from Pre-press or 
potential work for art shows and award entries. >

Click to view Fallon’s Font Licensing policy
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Broadcast Production 
Studio Editor receives work from Project Management and begins to create 
asset based on specific criteria.

For TV:
Studio Editor receives DigiBeta from Producer/Mike Aaron or directly from the 
video-finishing facility, as detailed in TV/Finishing specs document.

Studio Editor creates a Thumbnail image from a key scene within the spot.  
(NOTE: Please ensure that Thumbnails are consistent between various versions 
of the same spot.)

For radio:
Radio Producer receives CD with MP3 of finished spot(s) from the audio 
recording studio.
 
MeTadaTa For boTh TV and radio:
Studio Editor receives partial Metadata from the Producer’s Broadcast Job 
Report form before the shoot takes place.

After completion of the spot, Studio Editor receives finished Metadata from the 
Broadcast Job Report.

applicaTion-SpeciFic inSTrucTionS For MpeG and Mp3 creaTion

AVID Final Cut Pro Cleaner iTunes (for radio spots) Quicktime Pro

naMinG The File

Studio Editor should follow this format for naming the file:
AD-ID_Spot Title_A (for Agency version only)_spot length.mpg (.mp3 for radio)

Last step for Broadcast Production: Uploading the asset to the Creative Library.
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DETAILS FOR TV
DETAILS FOR 

RADIO

RECEIVE METADATA

APPLICATION-SPECIFIC 
DETAILS

UPLOAD Agency version: Version A spots. These spots do not go to the client 
(often clients don’t even know they’ve been created), 
but they are the spots we enter for award shows and 
put on all Fallon presentation tapes.

Air version: The version that airs on TV and goes to the client.

send an eMail to:

LISA ROgERS

BRAD ZENNER

WADE STUART

Click to go to the Broadcast Production 
Application-Specific Details

Creating a Thumbnail Image:
Open the MPEg file in Quicktime Pro.

Play the spot. Click the Edit Menu and choose Copy to 
grab a representative frame.

Paste the image in the Metadata form in Cumulus.  >

Partial Metadata from the 
Broadcast Job Report is received 
via email. Copy the contents and 
paste into Cumulus. View a sample 

Broadcast Job Report

View a sample of 
a TV/Radio finish 
specs document

Sample Filename:
QZBJ5013_EscapeRev1_30.mpg  >
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uPloading files

1. Mount the Library share of the MsP-Mainserver…For Macs, click Connect to 
server, type in afp://msp-mainserver.msp.fallon.com. When prompted, type 
in your username and password, and then choose Library from the list. It will 
be placed on your desktop.

2. Go into the correct folder where your asset belongs. It is important that the 
file goes into the year folder, not the type folder. Copy the asset into the 
year folder.

3. open the Cumulus application.

4. Click once on Library on the left-hand side.

5. Click the File Menu, choose Catalog Assets (APPLE+B).

6. Navigate to the file in the Library server and click Choose.

7. In Cumulus, on the left-hand side of the page, open the year Folder where 
the file was uploaded by clicking on it.

8. once you see the asset on the right-hand side of the page, double-click on it 
and add in the Metadata in the Notes field, add in the Ad Copy, and choose 
your office’s location. For Broadcast Production, add the thumbnail image.

9. Confirm the file and data have been entered by going to 
 http://creativelibrary.fallon.com

MoRE UPLoAdING INFo

CoNNECTIoN To sERvER

CUMULUs CLIENT

CUMULUs sCAN

Add METAdATA

CoPy AssET

FoR ALL: 
MARk APPRovEd

BRoAdCAsT 
PRodUCTIoN: CREATE/

UPLoAd THUMBNAIL

ART PRodUCTIoN: 
CHECk FoR REPRINT

vERIFy
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Click to go to the Metadata pages

The folder structure of the FCL works like this:

- Current and Historical Clients, Fallon internal work
 - Client
  - Type of Work
   - year of Work

All files are uploaded into the year folder.

New client?

Click to see how to add a 
new client to the FCL

It is the Print Producer’s job to go into Cumulus 
to select if there is a reprint available.

Print this section

Print entire Manual

Print this section

Print entire Manual

http://creativelibrary.fallon.com
mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Project 
ManageMent

Broadcast 
Production

art
Production

uPloading details

Page 10return to 
Previous PageExit

tablE of 
ContEnts

softwaRe RequiReMents

for uPloading files: 
Cumulus version 6.03 service Pack 1
Cumulus User Account created by Minneapolis IT

for art Production: 
Adobe Illustrator, Indesign, Photoshop, or
QuarkXpress, or  
Macromedia Freehand
Adobe Acrobat standard or Professional version 6
 

for broadcast Production: 
AvId, Final Cut Pro, or discreet Cleaner 6
iTunes for MP3 spots
Quicktime Pro for thumbnail creation

Access to connect to the Library share of the MsP-Mainserver
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If you need help accessing the Library 
share or any of the software listed 
above, go to the Who to Call page.

Print this section

Print entire Manual

Print this section

Print entire Manual

mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Project 
ManageMent

Broadcast 
Production

art
Production

uPloading details

Page 11return to 
Previous PageExit

tablE of 
ContEnts

cReative liBRaRy teRMinology

ProJect ManageMent

Representative version:  
We want to be consistent depending on the media buy. If each 
concept runs in the same publications, we can be consistent; for 
example, 7 x 10 page and 14 x 10 spread. This isn’t absolutely 
necessary, but whenever possible, we do it. We then email the 
Production artist, via 4d email tab, that this is the version that needs to 
be added to the creative library.

Team Members on a project:
Print Broadcast
Account director Account director
Account supervisor Account supervisor
Account Executive Account Executive
Project Manager Project Manager
Art Buyer Business Manager
Production Artist Broadcast Traffic
Print Producer Producer
Art director Art director
Copywriter Copywriter
Creative director Creative director
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broadcast Production terMinology

offline – online: offline is where all the creative development happens in the AvId; it easily 
allows making changes without high costs. 

 online is used for finessing the picture after AvId rough-cut approval. It can 
refer to telecine, mix or online editing. The work is done on more expensive 
machines, so it isn’t the place to make content changes.

Generic: A copy of a spot that does not have any supers, legal, logos, or fades. It is a 
source to revise from in the future. Assembly Line does not keep copies of 
Generics. (think of an MsRP car ad)

Agency version: version A spots. These spots do not go to the client (often clients don’t even 
know they’ve been created), but they are the spots we enter for award shows 
and put on all Fallon presentation tapes.

Air version: The version that airs on Tv and goes to the client.

dealer version: Refers to room for a “tag” at the end of the spot. A typical dealer version will 
be a :25/:05.

IsCI code: 4-letter/4-digit assigned code that changes with each new version of a spot. 
IsCI stands for International standard of Commercial Identification. All dub 
requests should be accompanied by an IsCI code to ensure accuracy of spots 
and their versions.

Ad-Id code: a universal digital advertising identification system developed by the AAAA 
and the ANA that was launched in december 2003 and will be used to track all 
types of media including Tv, print, radio, ooH, interactive, etc.  It will replace 
the current 8 digit IsCI system (with the exception of the prefix) with a 12 digit 
coding system that will guarantee a code number is never duplicated.  It will 
greatly benefit all clients as they can find out anything about an asset that has 
an Ad-Id code by the metadata associated with it. 

Bars: Color bars occur at the beginning of a tape to allow someone to adjust the 
color on their monitor before viewing. Usually bars are sent only to stations.
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Tone: sets a standard tone so the technician can adjust their audio levels before 
previewing the spot. Usually tone gets sent only to stations.

slate: Title card that typically appears on a master tape just before the broadcast 
material. This title card usually contains pertinent information regarding the 
material you are about to view. Information on a slate may include, length of 
the spot, date of it’s original creation, official title of the spot, the IsCI or Ad Id 
code, client’s name, type of audio track (stereo, mono, bit rate, etc.), name of 
the post house mastering the original tape, name of the agency creating the 
material and any copyright information relating to the spot/program.

MPeg sPecs: 
 video: MediaExcel MPEG-1  size: 352 x 240
 Format: NTsC    Frame Rate: 29.97 FPs
 video Bit Rate: 1150 kbps   Aspect Ratio: 4:3
 Audio: MPEG-1 layer II   sample Rate: 44.1 kHz
 Audio Bit Rate: 224 kbps   Format: stereo

All MPEGs should be encoded with one (1) second of black at the beginning and end of each 
spot.

MP3 sPecs:
 Audio Bit Rate: 192 kbps
 Audio sample Rate: 44,100 kHz
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aRt PRoduction teRMinology

high-resolution Processing

This is how the Minneapolis office handles high-res art processing for files going 
into the Fallon Creative Library:

once a job has been shipped to publications, our separator ships the final, high-
resolution, 300 dpi artwork to Fallon.

Print Production notifies the appropriate Project Manager and Production Artist 
that the art has been sent to Fallon.

The Production Artist assigned to the job receives the art and places it into the 
Archive folder on the MsP-Creative server. The Production Artist then saves a 
medium-resolution version of the artwork to be stored with the ad mechanicals 
and used in the PdF for the FCL. The high-res art from the Archive folder will be 
burned to the dvd archive and removed from the MsP-Creative server.

Two (2) copies of the Archive dvd will be made. one stays with Art Production, 
the other goes to Print Production.

A record of the contents of the Archive dvds goes into the Creative Archive 
search database, accessible to Art Production and Print Production, for later file 
retrieval.

Pdf sPecs:
 - PdF should be 150 dpi. should be Acrobat 5x compatible.
 - Job slug and printer’s marks should be included on the same page as 

the finished ad.

View fallon’s font licensing Policy
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Click to see an example of slug information

Click to go to Fallon’s Font Licensing policy
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Acrobat (Adobe 
application):

Adobe’s suite of products, under the Acrobat name, used to create, view 
and edit PdFs 

Art Production 
(studio):

Art Production department, responsible for working with Creative 
department, to generate comps, final mechanicals, and electronic art.

Bit-mapped 
(mode):

The Paint graphics mode describes an image made of pixels where the 
pixel is either on (black) or off (white). 

Bleed: An element that extends to the edge of the page. To print a bleed, the 
publication is printed on oversized paper which is trimmed. 

Body type: Roman—normal, plain, or book—type used for long passages of text, such 
as stories in a newsletter, magazine, or chapters in a book. Generally sized 
from 9 point to 14 point. see display type.

Camera-ready 
copy:

Final publication material that is ready to be made into a negative for a 
printing plate. May be a computer file or actual print and images on a 
board.

Color separation: The process of creating separate negatives and plates for each color of ink 
(cyan, magenta, yellow, and black) that will be used in the publication. see 
Process color separation, spot color separation. 

Comprehensive 
layout (comp):

A blueprint of the publication showing exactly how the type will be set and 
positioned, and the treatment, sizing, and placement of illustrations on the 
page. 

Compression: downsampling data-heavy elements (usually photos) of an electronic 
layout, to reduce size of file. Example: reducing resolution of artwork from 
300 dpi, to 72 dpi, to reduce overall file size. see downsample.

Continuous tone: Artwork that contains gradations of gray, as opposed to black-and-white 
line art. Photographs and some drawings, like charcoal or watercolor, 
require treatment as continuous-tone art. see Line art. 

Copy: Generally refers to text—typewritten pages, word-processing files, typeset 
galleys or pages—although sometimes refers to all source materials (text 
and graphics) used in a publication. 
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Crop marks: on a mechanical, horizontal and vertical lines that indicate the edge of the 
printed piece. 

Cropping: For artwork, cutting out the extraneous parts of an image, usually a 
photograph.

dPI (dots per 
inch):

The unit of measurement used to describe the resolution of printed output. 
The most common desktop laser printers output a 300 dpi. Medium-
resolution printers output at 600 dpi. Image setters output at 1270-2540 
dpi. 

downsample: Reducing the memory size of an electronic file, by eliminating electronic 
data. Usually accomplished by reducing the resolution of photos. see 
Compression.

Font: A set of characters in a specific typeface, at a specific point size, and in a 
specific style. “12-point Times Bold” is a font—the typeface Times, at 12-
point size, in the bold style. Hence, “12-point Times Italic” and “10-point 
Times Bold” are separate fonts. 

Greeked text: In page-assembly programs, text that appears as gray bars approximating 
the lines of type rather than actual characters. This speeds up the amount 
of time it takes to draw images on the screen. 

Gray-scale image: A “deep” bitmap that records with each dot its gray-scale level. The 
impression of greenness is a function of the size of the dot; a group of large 
dots looks dark and a group of small dots looks light. 

Halftone: In traditional publishing, a continuous-tone image photographed 
through a screen in order to create small dots of varying sizes that can be 
reproduced on a printing press. digital halftones are produced by sampling 
a continuous-tone image and assigning different numbers of dots, which 
simulate different sized dots, for the same effect. see dither, Gray-scale 
image, TIFF. 
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Halftone screen: In traditional publishing, the screen through which a continuous-tone 
image is photographed, measured in lines per inch. Although digital 
halftones are not actually photographed through a screen, the term is still 
used to describe the size of the dots; the larger the dots (fewer lines per 
inch), the more grainy the image. special screens can be used for special 
effects. see Mezzotint, solarization.

High-Res (high- 
resolution):

digital photography or artwork that is at an appropriate resolution for 
printing on a press—generally 300 dpi, or above. see Resolution.

Image area: The area on a page within which copy is positioned; determined by the 
margins. 

Landscape 
(orientation):

A page or layout that is wider than it is tall. 

Line art: Black-and-white artwork with no gray areas. Pen-and-ink drawings are line 
art, and most graphic images produced with desktop publishing graphics 
programs can be treated as line art. For printing purposes, positive 
halftones can be handled as line art. 

Logotype: A symbol, mark, or identifying name. 

Low-Res (low- 
resolution):

digital photography or artwork that is not at a suitable resolution for 
printing on a press—generally 72 dpi. see Resolution.

Medium-Res 
(medium- 
resolution):

digital photography or artwork that is not at a suitable resolution for 
printing on a press, but can be used for inkjet or laserwriter output 
devices—generally between 100-300 dpi. see Resolution.

offset printing: For high-volume reproduction—utilizes three rotating drums: a plate 
cylinder, a blanket cylinder, and an impression cylinder. The printing plate 
is wrapped around the plate cylinder, inked and dampened. The plate 
image is transferred, or offset, onto the blanket cylinder. Paper passes 
between the blanket cylinder and the impression cylinder, and the image is 
transferred onto the paper.
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PdF (Portable 
document 
Format):

The native file format for Adobe systems’ Acrobat . PdF is the file format 
for representing documents in a manner that is independent of the original 
application software, hardware, and operating system used to create 
those documents. A PdF file can describe documents containing any 
combination of text, graphics, and images in a device-independent and 
resolution-independent format.

Pica: A measurement used in typography for column widths and other 
space specifications in a page layout. There are 12 points in a pica, and 
approximately 6 picas to an inch. 

Pixel (picture 
element):

The smallest unit that a device can address. Most often refers to display 
monitors, a pixel being the smallest spot of phosphor that can be lit up on 
the screen. 

PMs (Pantone 
Matching system):

A standard color-matching system used by printers and graphic designers 
for inks, papers, and other materials. A PMs color is a standard color 
defined by percentage mixtures of different primary inks. 

Point: A measurement used in typography for type size, leading, and other 
space specifications in a page layout. There are 12 points in a pica, and 
approximately 70 points to an inch. 

Postscript: A trademark used for an object-oriented computer language for describing 
the appearance and layout of documents, used to print high-resolution text 
and graphics.

Printer font: High-resolution bitmaps or font outline masters used for the actual laying 
down of the characters on the printed page, as opposed to displaying 
them on the screen. see screen font. 

Process color 
separation:

In commercial printing, used for reproduction of color photographs. The 
various hues are created by superimposition of halftone dots of the process 
colors: cyan (a greenish blue), magenta (a purplish red), yellow, and black. 
see Color separation.

Resolution: The crispness of detail or fineness of grain in an image. screen resolution 
is measured in dots by lines (for example, 640 x 350); printer resolution is 
measured in dpi (for example, 300 dpi). 
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scaling: Reduction or enlargement of artwork, which can be proportional (most 
frequently) or disproportional. In desktop publishing, optimal scaling 
of bitmaps is reduction or enlargement that will avoid or reduce moiré 
patterns. 

screen font: Low-resolution (that is, screen resolution) bitmaps of type characters that 
show the positioning and size of characters on the screen. As opposed 
to the printer font, which may be high-resolution bitmaps or font outline 
masters. see Printer font. 

spot color 
separation:

For offset printing, separation of solid premixed ink colors (for example, 
green, brown, light blue, etc.); used when the areas to be colored are not 
adjacent. spot color separations can be indicated on the tissue cover of the 
mechanical, or made with overlays. 

spread: In a double-sided document, the combination of two facing pages, which 
are designed as a unit. Also, the adjacent inside panels of a brochure when 
opened. 

Tabloid-sized 
page:

A page that measures 11 x 17−most often used in portrait orientation for 
newspapers. Not to be confused with an 11 x 17 spread, which is made up 
of two letter-sized pages. 

Template: In page design, a file with an associated style sheet and all standing and 
serial elements in place on a master or base page, used for publication 
following the same design. 

Thumbnails: Miniature pictures sketched as first design ideas, like thinking on paper (or 
on screen). 

TIFF (Tagged 
Image File 
Format):

For digital gray-scale halftones, a device-independent graphics file format. 
TIFF files can be used on IBM/compatible or Macintosh computers, and 
may be output to Postscript printers. see Gray-scale image, Halftone. 

Tiling (tile): Printing a page layout in sections with overlapping edges so that the 
pieces can be pasted together. 

Typeface: The set of characters created by a type designer, including uppercase 
and lowercase alphabetical characters, numbers, punctuation, and special 
characters. A single typeface contains many fonts, at different sizes and 
styles. see Font. 
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Type families: A group of typefaces of the same basic design but with different weights 
and proportions. see Light, Black, Condensed, Expanded.

WysIWyG (What-
you-see-Is-What-
you-Get):

An interactive mode of computer processing in which there is a screen 
representation of the printed output. WysIWyG is never entirely accurate 
because of the difference in resolution between display screens and 
printers. 

x-height: The height of the lowercase “s.” sometimes referred to as “body height.” 
More generally, the height of the lowercase letters. 

sources: doug kipperman and deb Linder, 1997. The Free on-line dictionary of 
Computing, ©1993-2005 denis Howe.
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MoRe uPloading info - liBRaRy seRveR tasks

adding a new client using the new client teMPlate

open the Library server.
Copy the whole New Client Template folder into the Current folder.
Rename the New Client Template folder to the new Client Name.

creating a new year folder

open the Library server.
Navigate to the type of work folder and open.
Create a new folder in that location named only by yEAR.

adding a thuMbnail iMage to the Metadata

In Cumulus, double-click on the asset to view the Metadata.
In the Metadata, click on the current thumbnail to select it (there is a blue 
box around it).
open the mpeg in Quicktime Pro, click the Edit Menu and choose Copy 
for a representative still image of the spot.
Back in Cumulus, click the Edit Menu and choose Paste.

 

1.
2.
3.

1.
2.
3.

1.
2.

3.

4.
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MoRe uPloading info - fcl cuMulus tasks

All of these tasks involve files that have already been uploaded to the FCL but 
need modification.

renaMing a file

1. Copy the file up to the Library server.
2. Go into Cumulus, click once on the year folder, and catalog the assets.
3. double-click on the year folder, find the old file name and the new file name. 

double-click on each.
4. Copy and paste the Metadata from the old asset to the new one.
5. delete the old asset in Cumulus. To do that, use the key combination APPLE-

dELETE. When prompted, choose to delete both the asset and the record.

MoVing a file froM one folder to another

1. Find the file in the Library server, move it to the new location.
2. In Cumulus, click oNCE on the file oNE dIRECToRy higher (so, not the 

year, the type.)
3. on the right-hand side, sELECT ALL assets (APPLE-A) then CoNTRoL-click 

on the list and choose UPdATE AssET REFERENCE.

deleting a file

1. In Cumulus, navigate to find the asset in the right-hand window.
2. delete the asset with the key combination APPLE-dELETE. When prompted, 

delete both the asset and the record.
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Metadata standaRds

for tV/radio work:
Partial Metadata for the “Notes” field should always follow this format, and in-
clude first and last names, which is received from the Broadcast Job Report:

Client
Title 
Job #  
Ad-Id Code  
Creative director  
Art director
Copywriter 
Producer
director
Campaign
year

In the “Ad Copy” field, include this information:
Ad copy
Ad name
keyword(s)
Awards 

also, don’t forget about these settings:
select in the status if it’s Approved Work 

  Current Reel/Historical Reel
Label the spot length
select the office Location
Upload thumbnail image 

•
•
•
•
•
•
•
•
•
•
•

•
•
•
•

•

•
•
•
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Metadata standaRds (continued)

for Print work:
Metadata for the “Notes” section should always follow this format and include 
first and last names:

Creative director
Art director
Copywriter
Project Manager
Producer
Art Buyer
Production Artist
Campaign
year

In the “Ad Copy” field, include this information:
Ad copy
Ad name
keyword(s)
Awards 

also, don’t forget these settings: 
select the office Location
select if it’s Approved Work

Print Production’s role in the Metadata:
select if there is a Reprint available

•
•
•
•
•
•
•
•
•

•
•
•
•

•
•

•
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who to call

for content-related questions:

Lisa Rogers
supervisor, Project Management
612-758-2639

for technical questions:

Brad Zenner
Learning and development Manager
612-758-2511

Wade stuart
systems Administrator
612-758-2660
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naMing conventions

what characters can we use? Here is a list:

a b c d e f g h i

j k l m n o p q r

s t u v w x y z

A B C d E F G H I

J k L M N o P Q R

s T U v W X y Z

0 1 2 3 4

5 6 7 8 9

- (dash) _ (underscore) . (period)

naMing is iMPortant. Here are some important points:
do NoT use any special characters in the file name, such as: ! @ # $ 
% & * “ ‘ : ; / ? \ ] [ = +. oNLy use letters, numbers, spaces, dashes and 
underscores.
Make the filename as descriptive as possible. some things to include in 
the filename are: job number, title of ad, spot length (for Tv spots.)
Limit the filename to 26 characters, including the extension (for example, 
.pdf, .mpg, are characters that count toward the full filename.)

•

•

•
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QUICkTIME 
PRo

aPPlication-sPecific details

art Production aPPlication-sPecific details for Pdf creation

From any software, the suggested PdF format to use, if available, is Adobe PdF. 
This will ensure clean PdFs with fewer compatibility issues. In the software listed 
below, that is done through “Export” or “save As…”. Creating the pdf through 
the Print dialogue box does not always create an Adobe PdF.

PdF specs:
PdF should be 150dpi. should be Acrobat 5x compatible.
Job slug and Printer’s Marks should be included on the same page as the 
finished ad.

on the following pages, you will see the Art Production application-specific 
details for creating a PdF.

•
•

d
e

ta
il

s 
a

n
d
 a

PP
li

c
a

ti
o

n
 s

Pe
c

s

APPLICATIoN-sPECIFIC 
dETAILs

BRoAdCAsT 
PRodUCTIoN

art 
Production

ILLUsTRAToR

PHoTosHoP

QUARk

FREEHANd

AvId

CLEANER

FINAL CUT 
PRo

ITUNEs

INdEsIGN

send an eMail to:

LIsA RoGERs

BRAd ZENNER

WAdE sTUART

Print this section

Print entire Manual

Print this section

Print entire Manual

mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Project 
ManageMent

Broadcast 
Production

art
Production

uPloading details

Page ��return to 
Previous PageExit

tablE of 
ContEnts

illustrator cs

Click the FILE Menu, choose save A Copy.

In the dialogue box that appears, select Format: Adobe PdF (pdf). deselect 
Hide extension button.

In Adobe PdF options dialogue box, choose the preset: Custom. Then 
select the following options:

General: 
  Compatibility: Acrobat 5 (PdF 1.4)
  options: Embed Page Thumbnails
    optimize for Fast Web view

Compression:
 Color Bitmap Images: Avg downsampling To 150 ppi for images above 225 ppi
 Compression: JPEG  
 Image Quality: Maximum

 Grayscale Bitmap Images: Avg downsampling to 150 ppi for images above 225 ppi
 Compression: JPEG
 Image Quality: Maximum
 Monochrome Bitmap Images: do Not downsample
 select Compress Text and Line Art button

Marks & Bleeds:  None
security:  None

If you want to save these settings, select save Preset… and name the setting 
- FCL PdF settings.

Click the save PdF button.
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indesign cs

Click the FILE Menu, choose Export.

In the dialogue box that appears, select Format: Adobe PdF.

In the Export PdF dialogue box, select the following options:
Preset: [Custom]
General: options: Compatibility: Acrobat 5 (PdF 1.4)

     standard: None
     optimize for Fast Web view

Compression:
 Color Images: Bicubic downsampling to 150 ppi for images above 300 ppi.
  Compression: Automatic 
  Image Quality: Maximum
 Grayscale Images: Bicubic downsampling to 150 ppi for images above 300 ppi.
  Compression: Automatic 
  Image Quality: Maximum
 Monochrome Images: Bicubic downsampling to 800 ppi for images above 1200 ppi.
  Compression:  ZIP

select Compress Text and Line Art
deselect Crop Image data to Frames

Marks and Bleeds: None
Advanced - Color: Leave Unchanged
security:  None

If you want to save these settings, select save Preset… and name the setting 
- FCL PdF settings.

Click the Export button.
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PhotoshoP cs

Click the  FILE Menu, choose save As..

In the dialogue box that appears, select Format: Photoshop PdF. Check the 
save a Copy box.

In PdF options dialogue box, choose the following options:
Encoding: JPEG
Quality: High

select Image Interpolation.

Click ok.
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freehand MX

Click the FILE Menu, choose Export.

Next to Format:  select PdF.

Click the setup… button, and set PdF Export options like this:

Pages: however many pages you want included in the PdF.

Image Compression -  Color: High
    Grayscale: High

Convert Colors to: CMyk
Compatibility:  Acrobat 4
Compress text and graphics
Embed fonts

 
Click ok.

Click Export.
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quarkXPress 4.1X
(Adobe PdFs can be created by printing a Postscript file from Quark, then 
distilling the file through Acrobat distiller; or by printing through Create Adobe 
PdF, a free extension available with Acrobat 5 and earlier versions.)

generating an adobe Pdf without create adobe Pdf eXtension:

Click the FILE Menu, choose Print.

Working from left to right, clicking on the tabs in the middle of the Print 
dialogue box:

select the setup tab, choose the Printer description for the printer 
on which you would normally print your file, and any other print setup 
selections you would normally make.

select the output tab. Next to Halftoning, select Printer.

Now, using the buttons at the bottom of the Print dialogue box, click on the 
Page setup… button.

select the printer to which you would normally print the file, and the 
page size at which you want the PdF. Click ok.

Next, click on the Printer… button.
Under the pull-down menu, labeled General, select Postscript settings, 
then select these settings:

  Format: Postscript Job
  Postscript Level: Level 2 only
  data Format: Binary
  Font Inclusion: All

Under the destination: pull-down menu, select File. Click the save 
button.
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save the file to a location (the default location will be the same as your 
Quark document).

  
Next, in the Print dialogue box, click Print.

Quark will generate a Postscript file, with a .ps extension, that will be saved to 
the location you indicated. you will need to use Acrobat distiller, to convert the 
Postscript file to a PdF.
 

open Acrobat distiller
  

In the Acrobat distiller dialogue box, under Adobe PdF settings, select 
standard or Print Quality.

drag and drop your .ps file onto the Acrobat distiller dialogue box.
Wait for the status bar to read 100% complete. 
PdF will appear in same location as .ps file.

generating an adobe Pdf with the create adobe Pdf eXtension:

Under the File pull-down menu, select Print.

Working from left to right, clicking on the tabs in the middle of the Print 
dialogue box:

select the setup tab next to Printer description, choose Acrobat distiller, 
and any other print setup selections you would normally make.

select the output tab. Next to Halftoning, select Printer.
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Now, using the buttons at the bottom of the Print dialogue box, click on the 
Page setup… button.

select Create Adobe PdF, and the page size at which you want the PdF. 
Click ok.

Next, click on the Printer… button.

The default dialogue box should open to PdF settings, with File already 
selected in the upper right-hand corner. There will only be 2 areas of options 
you’ll need to check:

Job options- select the type of PdF you want. For the Creative Library, 
we use the Print setting.

After PdF Creation - your discretion.
save the file to a location (the default location will be the same as your 
Quark document).

  
Next, in the Print dialogue box, click Print.

Acrobat distiller will automatically launch, in the background, and create an 
Adobe PdF.
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BRoadcast PRoduction aPPlication-sPecific details  
foR MPeg cReation

MPeg sPecs: 
 video: MediaExcel MPEG-1  size: 352 x 240
 Format: NTsC   Frame Rate: 29.97 FPs
 video Bit rate: 1150 kbps  Aspect Ratio: 4:3
 Audio: MPEG-1 layer II  sample Rate: 44.1 kHz
 Audio Bit rate: 224 kbps  Format: stereo

All MPEGs should be encoded with 1 second of black at the beginning and end 
of each spot.

creating an MPeg follows this Process:

1. Import the digibeta into AvId or Final Cut Pro
2. Export the digitized file
3. open the digitized file in Cleaner
4. Cleaner will create the mpeg
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aVid (using Avid version 10.1 and higher or 
Avid Xpress / Xpress Pro version 5.0 or higher)

don’t forget to review the MPEG specs

Click the Tools Menu, select digitize.
Within the digitize Tool Menu, locate the Bin Menu.
Using the Bin Menu, select a bin to file the digitized spot. 

Using your preferred video deck (Beta sP, dv Cam, digibeta, vHs, etc.), 
scroll to the slate at the beginning of the spot you wish to encode.

To digitize the spot you will need to press the large red button on the 
digitize Tool menu while at the same time pressing Play on your selected 
video deck.

once the spot has been digitized to the appropriate bin, press the large red 
button again to stop the digitizing process.

Within the selected bin, double-click on the digitized clip.

The digitized clip will now appear in a timeline on the bottom of your 
screen.

Using the “in” and “out” keys (typically the “e” and “r” keys), select an 
appropriate “in” and “out” point for the digitized clip.  NoTE: you must 
have one second of black at the beginning and end of your marked “in” and 
“out” points. 
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Under the File Menu at the top, select the Export function.
Within the Export Menu, select the Export settings Menu toward the 
bottom.
Within the Export settings Menu, select Fast Export QuickTime

Choose a destination to save the exported file

once a destination has been selected, click the save button within the 
Export menu.

you will be prompted to name the file.

Choose a title that does not contains any symbols other than text, 
underscores and hyphens.

Click on the save button again.

The computer will export the file and save it to the proper destination.

Next, use Cleaner to take that exported file and create the mpeg.
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final cut Pro (version 3.0 or higher)

don’t forget to review the MPEG specs

Click the FILE Menu, select Capture

Within the Browser Menu (which comes up automatically when you open 
FCP), locate a bin to which you will digitize the material.

once you have located a bin, control-click on the folder icon, which sets the 
“Capture Bin” setting.

Using your preferred video deck (Beta sP, dv Cam, digibeta, vHs, etc.), 
scroll to the slate at the beginning of the spot you wish to encode.

To digitize the spot, you will need to press the “Capture Now” button on the 
digitize Tool menu while at the same time pressing Play on your selected 
video deck.

once the spot has been digitized to the appropriate bin, press the “Esc” 
key to stop the digitizing process.

Within the selected bin, double-click on the digitized clip.

The digitized clip will now appear in a timeline on the bottom of your 
screen.

Using the “in” and “out” keys (typically the “i” and “o” keys), select an 
appropriate “in” and “out” point for the digitized clip.  NoTE: you must 
have one second of black at the beginning and end of your marked “in” and 
“out” points. 
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Click the FILE Menu at the top, select the Export function.
Within the Export Menu, select the QuickTime Conversion option.
Within the QuickTime Conversion Menu, you will be prompted to name 
the file you are about to save.

Name the file with a title that does not contain any symbols other than text, 
underscores and hyphens.

Choose a destination to save the exported file.  

once a destination has been chosen, select the Format Menu and choose 
QuickTime Movie.

Now click on the options button to the right of the Format Menu.
Within the Movie settings/options Menu, select settings under the 
video heading.
Within the Compression settings/video heading, select Animation under 
the first menu.
Next, under the depth Menu, select Millions of Colors.
Next, under the Quality slide-bar menu, select Best.
Next, under the Motion/Frames per second Menu, select 29.97 (non-
drop frame.)

Click the save button within the save - Movie settings - Compression 
settings Menu. 

The computer will export the file and save it to the proper destination.

Next, use Cleaner to take that exported file and create the mpeg.

»
•
•

»

»

»

»
•

•

•
•
•

»d
e

ta
il

s 
a

n
d
 a

PP
li

c
a

ti
o

n
 s

Pe
c

s

APPLICATIoN-sPECIFIC 
dETAILs

BRoAdCAsT 
PRodUCTIoN

ART 
PRodUCTIoN

ILLUsTRAToR

PHoTosHoP

QUARk

FREEHANd

AvId

CLEANER

Final cut 
Pro

ITUNEs

INdEsIGN

QUICkTIME 
PRo

send an eMail to:

LIsA RoGERs

BRAd ZENNER

WAdE sTUART

Print this section

Print entire Manual

Print this section

Print entire Manual

mailto:Wade Stuart/FALMSP/USA/NA/FALLON


Project 
ManageMent

Broadcast 
Production

art
Production

uPloading details

Page �0return to 
Previous PageExit

tablE of 
ContEnts

creating an MPeg using discreet cleaner (version 6.0 or higher):

don’t forget to review the MPEG specs

once Cleaner has been opened, you will see a large window named 
“Untitled” on your desktop.

Locate the uncompressed QuickTime file within the folder in which it was 
saved, click and drag the file onto the “Untitled” window.

Highlight the file in the Cleaner window with your mouse while holding 
down the “Control” button on your keyboard.

A sub-menu will appear. Within that sub-menu, select the settings option.

Create a new setting by clicking the New setting button in the middle of the 
options screen.

Within the output/Format heading, select MPEG 1 & 2
Within the output/options menu, select set.
Within the options/Encode video as… Menu, select MPEG-1.

Next, select the Audio menu at the top of the MPEG Encoding options 
Menu.

Make sure that the audio sample rate is set to 44.1 kHz (it should be a 
factory default setting, but check just in case).

Next select the video menu at the top of the MPEG Encoding options 
Menu.

Under the MPEG-2 options/Image size Menu, manually enter 352 x 240 
(pixels).
Under the Quality/ speed Menu, select Fastest speed.
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Now click ok at the bottom of the menu.

Next, click the Apply button at the bottom of the settings Menu.

Now you are ready to encode the uncompressed QuickTime file.

select the green arrow key at the bottom of the window and you will be 
prompted to name the new mpeg and select a destination or file to which 
the mpeg will be saved.

select a title that does not contains any symbols other than underscores and 
hyphens.

Choose a destination to save the exported file.  The desktop is a easy 
location.

Click the save button and the file will begin its compression.

It will indicate the approximate duration for the encoding process and 
give you a visual indication as to what part of the file is currently being 
compressed.

The mpeg is complete.
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MP3 (audio) creation using itunes

Insert the Cd containing the Aiffs into your computer.  

once the Cd icon appears on your desktop, double-click on it and you will 
see all the audio tracks on that particular Cd. 

open iTunes.  In the source window at the bottom of the menu, click on the 
“+” sign to create a new folder.   

Title the folder and then double-click on the folder you have just created.   

Highlight all the tracks on the Cd you wish to convert and drag those tracks 
into the empty area that is your new folder.   

Highlight all the tracks in the new area, and under the Advanced Menu 
choose Convert selection to MP3.”  

The iTunes will automatically convert all the AIFFs to MP3s. 

At the top of the source area of iTunes, click once on the Library button. 

In the search tab at the upper right of your iTunes, type in the name of the 
track that you have just converted.  you will see two of the same tracks, but 
don’t be confused.  one is the original AIFF, and the other is your new MP3.  
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creating a thuMbnail froM an MPeg (using QuickTime Pro)

open the MPEG file in Quicktime Pro.

Play the spot. Click the Edit Menu and choose Copy to grab a representative 
frame.

Paste the image in the Metadata form in Cumulus.

NoTE: If uploading multiple versions of a spot, use a consistent thumbnail 
image for all spots.
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A TV/Film Job Report has been completed.  

  

Here is the metadata information for the Creative 

Library: 

 

  

Campaign:  Brand/Shower Music Info: 

Spot Title(s):  Chopper  

Client:  Holiday Inn Express --- Track 1 --- 

Job Number:  HEX10350 Music Demos/Stock:   

Product:  Brand/Shower Music Final:   

First Airdate:  05/09/2005 Music Type:  None 

Office:  MSP Music Dates:   

 Music Use:   

Agency:  Fallon Song Title:   

Executive Creative Director:  Paul Silburn Composer(s):   

Creative Director:  Bobby Pearce Performer(s):   

Group Creative Director:  Bobby Pearce Publisher:   

Art Director:  Scott OLeary Licensing Agent:   

Copywriter:  Ryan Peck  

Director of Broadcast:  Brian DiLorenzo Sound Design:  Bug Editorial 

Executive Producer:  Joe Grundhoefer VO Talent:  Sean Donellan 

Producer:  Joe Grundhoefer Talent Rate:  Overscale 

Assistant  Producer:  none VO/Studio/Record:  BWN 

Business Manager:  Tammy Oellien Mix Co & Dates:  Ravenswork (CA) / Robert Feist / 

May 10,2005 

 Talent Agent:   

Spot Info: Music Comments:  no music other than end tag 

sting 

XHMX4197  Chopper  Air  :30  

ZFSN4110  Chopper  Agency  :30  

  

Production Company:  Moxie Pictures, Inc.  

Prod Co Phone:  323.957.5420  

Director:  Martin Granger  

Director of Photography:  Stefan Czapsky  

Prod Co Executive Producer:  Robert Fernandez  

Prod Co Producer:  Heidi Soltesz  

Shoot Dates/Loc:  3/16/05  

Film Stock:  35mm  

Edit House:  Bug Editorial  

Editor:  Andre Betz  

Film/Tape Trans:  CO. 3 (NYC) Billy Gabor  

On-line:  A52 (CA)  

Spec Effects/Titles:  A52 (CA)  

Master Location:  Point.360/Hollywood  

Safety:  Pixel Farm / Mpls  

Elements Location:  Point 360 / Hollywood  

Other Info:    

Audio Master Copy:  Sent to Sound 80  

 



Client: FMR  FALLON

Job #: fmr10869v1

Ad title: Award Winning Ad  

File name: nc_slugmap

File created mm-dd-yyyy: 09-03-2004

Application: Adobe InDesign 2.0.2 on Mac OS 10.2.8

Revision #: 4 Modify log: 09-22-2004 15:22:15 Modified by: mwaite

09-08-2004 09:56:35 Modified by: mwaite

  

Jamie Davies Account Executive

Shawn Smith Art Buyer

James Zucco Art Director

Jen Stocksmith Writer

Stuart D’Rozario Creative Group Head

Michael Waite Studio Artist

Paul Morita Production Manager 

Lisa Rogers Traffic Manager

Newsweek 12/01/04 10/15/04 00/00/00

Time 12/01/04 10/15/04 00/00/00

Bleed: 8 1/2" x 11"

Trim: 8 1/4" x 10 13/16"

Live: 7' x 10"

Gutter: 1/2 all sides

Die: n/a

Media: 4/C Full Page Bleed

Ink: CMYK

Fallon | Minneapolis1

Fonts:

Arial Black Regular

Arial Regular

Zapf Dingbats Regular

 
Publications: Issue: Close: Ext:



TV Finishing Specs 
 
Immediately upon client approval and completion, please do the following... 
Make FOUR DigiBeta dub masters with all versions, including generics which 
must be slated:  “NOT FOR AIR” 
 

• Overnight (1) DigiBeta– with  aal l  versions-  to: 
Point.360 
Attn:  Justin Smith 
1025 N. McCadden Place 
Hollywood, CA   90038 
323-461-8383 (Main #) 

 

• Overnight (1) DigiBeta – with  aal l  vers ions - to: 
Chris Chiabotti 
Pixel Farm 
251 First  Avenue North, Suite 600 
Minneapolis, MN  55401 
612/339-7644 

 
• Overnight (1) DigiBeta – with  aal l  vers ions -to: 

Michael Aaron/Chad Nelson 
Fallon Assembly Line 
50 South Sixth Street, 28th Floor 
Minneapolis, MN  55402 
612/758-2234 

 

• Include (1) DigiBeta – with aal l  versions  - with 
the production elements 

 
*NOTE:  Version A spots are used for the agency reel  and award 
shows.  This version should be the creative director approved 
version.   DO NOT LABEL ANY VERSION OF A SPOT AS AN "AWARD 
VERSION."   If there's an alternate cut of an air version,  it should be 
labeled:  "PERSONAL/. . . " .  Be it . . .creative team cut ,  . . .director cut ,  etc.   
ALL GENERIC VERSIONS MUST BE SLATED:  “NOT FOR AIR” 
 
*Make ONE MPEG (320 x 240) , UNSLATED of each version, burn to CD and send to 
Mike Aaron/Chad Nelson at Fal lon.   See address above . 
 
*Make ONE CD of al l  graphic elements and iconography used in the tit le/logo 
sequences .  F iles should be uncompressed in e ither Adobe Photoshop or Il lustrator 
formats.   Th is CD should also be sent to Mike Aaron/Chad Nelson at Fal lon . 



 
 

Make TWO CD's with full mix and splits of each air-version spot. 
 
• Ship (1) CD via overnight delivery to: 

Sound 80 
Attn:  Mary Carter 
4027 IDS Center 
Minneapolis, MN   55402 
612-339-9313 

 
•Please include the remaining CD with the production elements. 
 
Above CDs must be very clearly labeled with the following:  
-Client Name + Product + "TV"  (i.e. Holiday Inn EExpress TV) 
-Please label each track with a track description, ISCI Code (where applicable), 
Title, and Length. CD MUST HAVE ISCI CODE LISTED!!  
 
 
Ship all production elements, vvery clearly labeled with Holiday Inn 
Express ,  ISCI codes,  t it les and lengths, along with an inventory list to: 
Poinst.360 Vault 
Attn:  Vault Manager 
6417 Selma Ave. 
Hollywood, CA   90028 
323/461-8383 
 
Please fax element inventory and waybills/tracking numbers for any 
shipped items to Rae Milosevich at 612/758-6221.   Thank you.    
 
 
 
RADIO Finishing Specs:  
 
(1) mp3 to Assembly Line (email to Mike Aaron/Chad Nelson) 
 
(1) CD to Sound 80 with full mix and splits (MUST HAVE CLIENT NAME, CODE #'S 

AND TITLES ON LABEL AND LIST THAT THESE ARE RADIO SPOTS!) 
 
(1) CD to The Keep with full mix and splits  (MUST HAVE CLIENT NAME, CODE #'S 

AND TITLES ON LABEL AND LIST THAT THESE ARE RADIO SPOTS!) 
 



FALLON FONT POLICY

DO NOT add your own fonts to our system. 
Use only fonts Fallon has a proper license for. 
DO NOT send fonts to a third party. 
Only send fonts to vendors who understand that: 
 they must use the font only on the Fallon project, then delete it. 

the details:

We do not own fonts. 
We license fonts.
 For legal purposes, fonts are considered software. 
 So like most software, we purchase licenses that permit use, with limitations.
We sign an End User License Agreement (EULA) for each font we use. 
There’s no standard agreement—each font provider writes their own agreement. 

basic restrictions

All EULAs restrict giving, sharing, and distributing the font to a third party. 
Use is limited to a certain number of computers. We license fonts for 75-100 users.
Nearly all licenses limit use to one site. 
Most, but not all, licenses allow for a font to be sent with a job to a vendor, as long as they 
understand to use it and delete it, or purchase a license for themselves. 

other possible restrictions

Using a font in a logo may require contacting the maker and paying a fee. 
Use of a font in a product name may have restrictions. 
Altering the font may not be allowed. 
Each font provider writes their own rules. 

the exceptions:

1) BMW created their own font, BMWType. 
2) Citibank has an unlimited license for Citi OCRK. 
3) Fallonfont is a font we made.   
These fonts can be distributed freely.

your computer

It’s very IMPORTANT that we only use fonts for which we have licenses. 
DO NOT add your own fonts to our system. 
Use only the fonts in the abc’s of Fallon, or fonts Bob Blewett gives you. 
(He has access to some fonts for which we have limited licenses.)



system fonts

System fonts come with your computer’s operating system and software. Not long ago there 
were only a few like, Arial, Chicago and Geneva. Now there are dozens, many end in “.dfont”. 
They shouldn’t be used for client work. You can see which ones they are by turning 
your list in Suitcases to System Fonts. 

free fonts

Avoid free fonts—nothing in life is free. Nearly all fonts come with a read-me. 
That read-me will usually say, “not for commercial use”. Also free fonts are of unknown quality. 
A free font may be an opportunity to test-drive a new font (usually an incomplete version 
of the font).  If you do download one, temporarily install it in Suitcase and delete when done.

outside designers, freelancers, other agencies with whom we work:

Need to own their own licenses for the fonts we use. 
May need to supply them with the information needed to order the font. 

embedding fonts     

Embedding fonts is an issue today. A type designer’s hard work can be instantly 
available to the whole world. A separate embedding license is typically required 
to embed fonts into editable documents or web pages. Foundries place restrictions 
on the types of documents into which fonts may be embedded.  

account people, project managers

May have to explain to a client why we can’t send the font to them or a third party. 
May need to forward font purchasing details to clients and vendors
May need to add the purchase of font licenses into client budgets. 

art directors, designers, studio, interactive 

Need to communicate font needs and usage so there’s time to properly purchase licenses. 

It’s important that we honor the type designers and type foundries.  
If you have a question, email bob.blewett@fallon.com or call Bob Blewett, 12769. 

for more information about legal use of fonts, see: 

www.fontwise.com/goldenrules.asp

or download the AIGA pdf, Use of fonts, at:   
www.aiga.org/content.cfm/designbusinessandethics

www.aiga.org/content.cfm/designbusinessandethics
www.fontwise.com/goldenrules.asp


Fallon University

Fallon Creative Library Usage
Quick Reference Guide

Can’t find what you’re looking for?

Call the Fallon IT Help Line at 
x18888 or 612.758.2770

Navigating around the FCL

Advanced Searching Options

Options when
clicking on an Asset

stores assets to download

shows metadata view for the asset

opens the asset

add asset to reprint request form

Identifies that the Asset 
is available as a reprint

Navigation pane: Click on the red arrows to 
expand the list. Double-click on the items to 
view at the contents of that section.

Different viewing 
options available

Number of records 
in that section

Reprint Order: Add assets to your 
reprint request, then click this 
button to submit the order

Collection Basket: Add assets 
to your collection basket to 
download as a zip file

Search by any keyword (i.e. 
name, job number, title, etc.)



Applications of FCL Assets

Adding work into a Powerpoint Presentation

Print Work - PDFs
MPEGs

In the FCL, click on the Asset and 
choose SHOW ORIGINAL

In the Acrobat window, click on 
the Snapshot Tool and CLICK 
and DRAG to set the area you 
want to insert into Powerpoint

Go into Powerpoint and choose PASTE

Uploading to the Extranet

In the FCL, add the items to your 
Collection Basket

In the Collection Basket, choose 
Download All Assets as a Zip and 
save that zip file to your desktop

Log into the Extranet, go to Upload Files, then navigate to the 
DocRepositories folder where you want to place the Zip file

In the FCL, click on the Asset and 
choose ADD TO COLLECTION BASKET

In the Collection Basket, click on the Asset 
and choose DOWNLOAD ASSET AS ZIP. Down-
load the file to your computer.

Unzip the file. Go into Powerpoint and insert 
the mpeg by clicking the INSERT Menu and 
choosing Movies and Sounds from File. 

1
2

3

1

2

3

1

2

3


	Button 155: 
	Project Management 28: 
	Art Production 28: 
	Uploading 28: 
	FAQ 28: 
	UseThisManual 2: 
	TOC page: 
	background: 
	FAQ 56: 
	Project Management 56: 
	PM: 
	PM verify: 
	Art Production 56: 
	ap toc: 
	Broadcast Production 56: 
	Bp toc: 
	Uploading 56: 
	upload toc: 
	overview toc: 
	background toc: 
	details toc: 
	pm terms toc: 
	ap terms toc: 
	bp terms toc: 
	more upload toc: 
	metadata toc: 
	who to call toc: 
	naming toc: 
	user guide link: 
	illustrator toc: 
	indesign toc: 
	photoshop toc: 
	freehand toc: 
	quark toc: 
	avid toc: 
	fcp toc: 
	cleaner toc: 
	itunes toc: 
	qt pro toc: 
	AP App Spec toc: 
	BP App Specs toc: 
	Project Management: 
	Art Production: 
	Uploading: 
	FAQ: 
	UseThisManual 4: 
	TOC page 2: 
	background 2: 
	overview: 
	Version button: 
	type button: 
	metadata: 
	Project Management 2: 
	Broadcast Production 2: 
	Art Production 2: 
	Uploading 2: 
	FAQ 2: 
	overview 2: 
	Button 113: 
	Button 114: 
	Button 145: 
	Project Management 3: 
	Art Production 3: 
	Uploading 3: 
	FAQ 3: 
	Version button 2: 
	type button 2: 
	metadata 2: 
	overview 4: 
	Project Management 5: 
	Art Production 5: 
	Uploading 5: 
	FAQ 5: 
	AP App Specs: 
	metadata 4: 
	overview 5: 
	Button 115: 
	Button 116: 
	Button 117: 
	Button 118: 
	Button 151: 
	Project Management 6: 
	Art Production 6: 
	Uploading 6: 
	FAQ 6: 
	Other Events: 
	metadata 5: 
	Thumbnail: 
	Printmetadata: 
	overview 7: 
	Button 128: 
	Button 129: 
	Button 130: 
	Button 149: 
	Project Management 7: 
	Art Production 7: 
	Uploading 7: 
	FAQ 7: 
	metadata 15: 
	Who to Call 27: 
	naming 27: 
	other events 27: 
	AP App Specs 27: 
	BP App Specs 27: 
	Software 4: 
	AP terms link 4: 
	BP terms link 4: 
	PM Terms link 4: 
	overview 8: 
	Button 150: 
	Project Management 8: 
	Art Production 8: 
	Uploading 8: 
	FAQ 8: 
	metadata 36: 
	Who to Call 31: 
	naming 31: 
	other events 31: 
	AP App Specs 31: 
	BP App Specs 31: 
	Software 9: 
	AP terms link 9: 
	BP terms link 9: 
	PM Terms link 9: 
	overview 9: 
	Project Management 19: 
	Art Production 19: 
	Uploading 19: 
	FAQ 19: 
	Who to Call 29: 
	naming 29: 
	other events 29: 
	AP App Specs 29: 
	Software 6: 
	AP terms link 6: 
	BP terms link 6: 
	PM Terms link 6: 
	overview 41: 
	metadata 42: 
	BP App Specs 39: 
	Project Management 18: 
	Art Production 18: 
	Uploading 18: 
	FAQ 18: 
	Who to Call 33: 
	naming 33: 
	other events 33: 
	AP App Specs 33: 
	Software 11: 
	AP terms link 11: 
	BP terms link 11: 
	PM Terms link 11: 
	overview 10: 
	metadata 38: 
	BP App Specs 33: 
	Project Management 29: 
	Art Production 29: 
	Uploading 29: 
	FAQ 29: 
	Who to Call 30: 
	naming 30: 
	other events 30: 
	AP App Specs 30: 
	Software 7: 
	AP terms link 7: 
	BP terms link 7: 
	PM Terms link 7: 
	overview 40: 
	metadata 43: 
	BP App Specs 40: 
	Button 152: 
	Button 154: 
	Project Management 31: 
	Art Production 31: 
	Uploading 31: 
	FAQ 31: 
	Who to Call 34: 
	naming 34: 
	other events 34: 
	AP App Specs 34: 
	Software 12: 
	AP terms link 12: 
	BP terms link 12: 
	PM Terms link 12: 
	overview 11: 
	metadata 39: 
	BP App Specs 34: 
	Project Management 32: 
	Art Production 32: 
	Uploading 32: 
	FAQ 32: 
	Who to Call 32: 
	naming 32: 
	other events 32: 
	AP App Specs 32: 
	Software 8: 
	AP terms link 8: 
	BP terms link 8: 
	PM Terms link 8: 
	overview 39: 
	metadata 44: 
	BP App Specs 41: 
	Project Management 33: 
	Art Production 33: 
	Uploading 33: 
	FAQ 33: 
	Who to Call 35: 
	naming 35: 
	other events 35: 
	AP App Specs 35: 
	Software 13: 
	AP terms link 13: 
	BP terms link 13: 
	PM Terms link 13: 
	overview 12: 
	metadata 40: 
	BP App Specs 35: 
	Project Management 34: 
	Art Production 34: 
	Uploading 34: 
	FAQ 34: 
	Who to Call 36: 
	naming 36: 
	other events 36: 
	AP App Specs 36: 
	Software 10: 
	AP terms link 10: 
	BP terms link 10: 
	PM Terms link 10: 
	overview 38: 
	metadata 45: 
	BP App Specs 36: 
	Project Management 35: 
	Art Production 35: 
	Uploading 35: 
	FAQ 35: 
	Who to Call 37: 
	naming 37: 
	other events 37: 
	AP App Specs 37: 
	Software 14: 
	AP terms link 14: 
	BP terms link 14: 
	PM Terms link 14: 
	overview 13: 
	metadata 41: 
	BP App Specs 37: 
	overview 37: 
	Project Management 36: 
	Art Production 36: 
	Uploading 36: 
	FAQ 36: 
	Who to Call 38: 
	naming 38: 
	other events 38: 
	AP App Specs 38: 
	Software 15: 
	AP terms link 15: 
	BP terms link 15: 
	PM Terms link 15: 
	metadata 46: 
	BP App Specs 38: 
	overview 14: 
	Button 131: 
	Button 133: 
	Project Management 38: 
	Art Production 38: 
	Uploading 38: 
	FAQ 38: 
	Who to Call 40: 
	naming 40: 
	other events 40: 
	AP App Specs 40: 
	Software 17: 
	AP terms link 17: 
	BP terms link 17: 
	PM Terms link 17: 
	metadata 53: 
	BP App Specs 42: 
	overview 36: 
	Project Management 39: 
	Art Production 39: 
	Uploading 39: 
	FAQ 39: 
	Who to Call 41: 
	naming 41: 
	other events 41: 
	AP App Specs 41: 
	Software 18: 
	AP terms link 18: 
	BP terms link 18: 
	PM Terms link 18: 
	metadata 50: 
	BP App Specs 43: 
	overview 15: 
	Button 134: 
	Button 135: 
	Project Management 40: 
	Art Production 40: 
	Uploading 40: 
	FAQ 40: 
	Who to Call 42: 
	naming 42: 
	other events 42: 
	AP App Specs 42: 
	Software 19: 
	AP terms link 19: 
	BP terms link 19: 
	PM Terms link 19: 
	metadata 51: 
	BP App Specs 44: 
	overview 35: 
	Button 136: 
	Project Management 41: 
	Art Production 41: 
	Uploading 41: 
	FAQ 41: 
	Who to Call 43: 
	naming 43: 
	other events 43: 
	AP App Specs 43: 
	Software 20: 
	AP terms link 20: 
	BP terms link 20: 
	PM Terms link 20: 
	metadata 48: 
	BP App Specs 45: 
	overview 16: 
	Project Management 42: 
	Art Production 42: 
	Uploading 42: 
	FAQ 42: 
	Who to Call 44: 
	naming 44: 
	other events 44: 
	AP App Specs 44: 
	Software 21: 
	AP terms link 21: 
	BP terms link 21: 
	PM Terms link 21: 
	metadata 52: 
	BP App Specs 46: 
	overview 34: 
	Project Management 43: 
	Art Production 43: 
	Uploading 43: 
	FAQ 43: 
	Who to Call 45: 
	naming 45: 
	other events 45: 
	AP App Specs 45: 
	Software 22: 
	AP terms link 22: 
	BP terms link 22: 
	PM Terms link 22: 
	metadata 49: 
	BP App Specs 47: 
	overview 17: 
	Project Management 13: 
	Art Production 13: 
	Uploading 13: 
	FAQ 13: 
	QTPro: 
	iTunes: 
	Cleaner: 
	FCP: 
	AVID: 
	Illustrator: 
	InDesign: 
	Photoshop: 
	Freehand: 
	Quark: 
	bp app specs: 
	ap app specs: 
	overview 33: 
	Button 137: 
	Button 138: 
	Project Management 15: 
	Art Production 15: 
	Uploading 15: 
	FAQ 15: 
	QTPro 2: 
	iTunes 2: 
	Cleaner 2: 
	FCP 2: 
	AVID 2: 
	Illustrator 2: 
	InDesign 2: 
	Photoshop 2: 
	Freehand 2: 
	Quark 2: 
	bp app specs 2: 
	ap app specs 2: 
	overview 18: 
	Button 139: 
	Button 140: 
	Project Management 16: 
	Art Production 16: 
	Uploading 16: 
	FAQ 16: 
	QTPro 3: 
	iTunes 3: 
	Cleaner 3: 
	FCP 3: 
	AVID 3: 
	Illustrator 3: 
	InDesign 3: 
	Photoshop 3: 
	Freehand 3: 
	Quark 3: 
	bp app specs 3: 
	ap app specs 3: 
	overview 32: 
	Button 141: 
	Project Management 17: 
	Art Production 17: 
	Uploading 17: 
	FAQ 17: 
	QTPro 4: 
	iTunes 13: 
	Cleaner 13: 
	FCP 13: 
	AVID 13: 
	Illustrator 13: 
	InDesign 13: 
	Photoshop 13: 
	Freehand 13: 
	Quark 13: 
	bp app specs 4: 
	ap app specs 4: 
	overview 19: 
	Project Management 20: 
	Art Production 20: 
	Uploading 20: 
	FAQ 20: 
	QTPro 5: 
	iTunes 4: 
	Cleaner 4: 
	FCP 4: 
	AVID 4: 
	Illustrator 4: 
	InDesign 4: 
	Photoshop 4: 
	Freehand 4: 
	Quark 4: 
	bp app specs 5: 
	ap app specs 5: 
	overview 31: 
	Project Management 21: 
	Art Production 21: 
	Uploading 21: 
	FAQ 21: 
	QTPro 6: 
	iTunes 5: 
	Cleaner 5: 
	FCP 5: 
	AVID 5: 
	Illustrator 5: 
	InDesign 5: 
	Photoshop 5: 
	Freehand 5: 
	Quark 5: 
	bp app specs 6: 
	ap app specs 6: 
	overview 20: 
	Project Management 22: 
	Art Production 22: 
	Uploading 22: 
	FAQ 22: 
	QTPro 7: 
	iTunes 6: 
	Cleaner 6: 
	FCP 6: 
	AVID 6: 
	Illustrator 6: 
	InDesign 6: 
	Photoshop 6: 
	Freehand 6: 
	Quark 6: 
	bp app specs 7: 
	ap app specs 7: 
	overview 30: 
	Project Management 23: 
	Art Production 23: 
	Uploading 23: 
	FAQ 23: 
	QTPro 8: 
	iTunes 7: 
	Cleaner 7: 
	FCP 7: 
	AVID 7: 
	Illustrator 7: 
	InDesign 7: 
	Photoshop 7: 
	Freehand 7: 
	Quark 7: 
	bp app specs 8: 
	ap app specs 8: 
	overview 21: 
	Project Management 24: 
	Art Production 24: 
	Uploading 24: 
	FAQ 24: 
	QTPro 9: 
	iTunes 8: 
	Cleaner 8: 
	FCP 8: 
	AVID 8: 
	Illustrator 8: 
	InDesign 8: 
	Photoshop 8: 
	Freehand 8: 
	Quark 8: 
	bp app specs 9: 
	ap app specs 9: 
	overview 29: 
	Button 142: 
	Project Management 25: 
	Art Production 25: 
	Uploading 25: 
	FAQ 25: 
	QTPro 10: 
	iTunes 9: 
	Cleaner 9: 
	FCP 9: 
	AVID 9: 
	Illustrator 9: 
	InDesign 9: 
	Photoshop 9: 
	Freehand 9: 
	Quark 9: 
	bp app specs 10: 
	ap app specs 10: 
	overview 22: 
	Project Management 26: 
	Art Production 26: 
	Uploading 26: 
	FAQ 26: 
	QTPro 11: 
	iTunes 10: 
	Cleaner 10: 
	FCP 10: 
	AVID 10: 
	Illustrator 10: 
	InDesign 10: 
	Photoshop 10: 
	Freehand 10: 
	Quark 10: 
	bp app specs 11: 
	ap app specs 11: 
	overview 28: 
	Button 143: 
	Project Management 27: 
	Art Production 27: 
	Uploading 27: 
	FAQ 27: 
	QTPro 12: 
	iTunes 11: 
	Cleaner 11: 
	FCP 11: 
	AVID 11: 
	Illustrator 11: 
	InDesign 11: 
	Photoshop 11: 
	Freehand 11: 
	Quark 11: 
	bp app specs 12: 
	ap app specs 12: 
	overview 23: 
	Project Management 30: 
	Art Production 30: 
	Uploading 30: 
	FAQ 30: 
	QTPro 13: 
	iTunes 12: 
	Cleaner 12: 
	FCP 12: 
	AVID 12: 
	Illustrator 12: 
	InDesign 12: 
	Photoshop 12: 
	Freehand 12: 
	Quark 12: 
	bp app specs 13: 
	ap app specs 13: 
	overview 27: 
	Button 144: 
	Project Management 37: 
	Art Production 37: 
	Uploading 37: 
	FAQ 37: 
	QTPro 14: 
	iTunes 14: 
	Cleaner 14: 
	FCP 14: 
	AVID 14: 
	Illustrator 14: 
	InDesign 14: 
	Photoshop 14: 
	Freehand 14: 
	Quark 14: 
	bp app specs 14: 
	ap app specs 14: 
	overview 24: 
	Project Management 44: 
	Art Production 44: 
	Uploading 44: 
	FAQ 44: 
	QTPro 15: 
	iTunes 15: 
	Cleaner 15: 
	FCP 15: 
	AVID 15: 
	Illustrator 15: 
	InDesign 15: 
	Photoshop 15: 
	Freehand 15: 
	Quark 15: 
	bp app specs 15: 
	ap app specs 15: 
	overview 25: 
	Project Management 45: 
	Broadcast Production 45: 
	Art Production 45: 
	Uploading 45: 
	FAQ 45: 
	QTPro 16: 
	iTunes 16: 
	Cleaner 16: 
	FCP 16: 
	AVID 16: 
	Illustrator 16: 
	InDesign 16: 
	Photoshop 16: 
	Freehand 16: 
	Quark 16: 
	bp app specs 16: 
	ap app specs 16: 
	Project Management 46: 
	Broadcast Production 46: 
	Art Production 46: 
	Uploading 46: 
	FAQ 46: 
	QTPro 17: 
	iTunes 17: 
	Cleaner 17: 
	FCP 17: 
	AVID 17: 
	Illustrator 17: 
	InDesign 17: 
	Photoshop 17: 
	Freehand 17: 
	Quark 17: 
	bp app specs 17: 
	ap app specs 17: 
	Back 28: 
	Forward 28: 
	Exit 4: 
	Print 4: 
	Contacts 4: 
	Return 4: 
	TOC page 1: 
	LR email: 
	BZ email: 
	WS email: 
	Print Section: 
	Print Manual: 
	Project Management 4: 
	Art Production 4: 
	Uploading 4: 
	FAQ 4: 
	Upload: 
	metadata 3: 
	BP App Specs: 
	overview 6: 
	Button 120: 
	Button 121: 
	Button 122: 
	Button 123: 
	Button 124: 
	Button 125: 
	Button 126: 
	Print Section2: 
	Print Section3: 
	Print Section4: 
	Print Section7: 
	Print Section8: 
	Print Section9: 
	Print Section10: 
	Print Section11: 
	Print Section12: 
	Print Section13: 
	Print Section14: 
	Print Section15: 
	Print Section16: 
	Print Section17: 
	Print Section18: 
	Print Section19: 
	Print Section20: 
	Print Section21: 
	Print Section22: 
	Print Section23: 
	Print Section24: 
	Print Section25: 
	Print Section27: 
	Print Section35: 
	Return New: 
	Text4: Continued on next page
	Text5: Print The Fallon Font Policy
	Button6: 
	Button7: 
	Text8: Print This Guide
	Button9: 
	Button10: 
	Button11: 
	user guide 4: 
	Broadcast Production 28: 
	Text5b: Print This Job Report
	Text5c: Print This Slugmap
	Text5d: Print The TV/Radio Finishing Specs


